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概要

この資料はコール詳細レコード（CDR）分析およびレポート（CAR）ツール Unified
Communications Manager （CallManager）のエラーメッセージに情報およびソリューションを



6.x/7.x/8.x on Cisco 提供したものです。

また、CDR 分析およびレポート（CAR）ツール エラーメッセージを参照して下さい: Error Code:
10011, System Error. 連絡先システム アドミニストレータ。

前提条件

要件

次の項目に関する知識があることが推奨されます。

Cisco Unified Communications Manager（CallManager） 5.x●

Cisco Unified Communications Manager（CallManager） 6.x●

Cisco Unified Communications Manager（CallManager） 7.x●

Cisco Unified Communications Manager（CallManager） 8.x●

Cisco コール詳細レコード（CDR）分析およびレポート（CAR）ツール●

使用するコンポーネント

この文書に記載されている情報は基づいた on Cisco Unified Communications Manager
（CallManager） 5.x/6.x/7.x/8.x です。

このドキュメントの情報は、特定のラボ環境にあるデバイスに基づいて作成されたものです。 こ
のドキュメントで使用するすべてのデバイスは、クリアな（デフォルト）設定で作業を開始して
います。 ネットワークが稼働中の場合は、コマンドが及ぼす潜在的な影響を十分に理解しておく
必要があります。

表記法

ドキュメント表記の詳細は、『シスコ テクニカル ティップスの表記法』を参照してください。

エラーコード 10011

CDR レポートを表示することが不可能

CDR レポートおよび CDR 検索 Unified Communications Manager （CallManager） 6.X を on
Cisco 表示する試みが行われるとき 10011  エラーメッセージによってが現れます。

データを収集する試みが行われるとき同様に CAR はデータを収集できないし、エラーメッセー
ジが現れます: 30061"。 この問題はまた Cisco バグ ID CSCsz99841 （登録ユーザのみ）で文書化
されています。

解決策

解決策 1

この問題を解決するには、次の手順を実行します。

//www.cisco.com/en/US/products/sw/voicesw/ps556/products_tech_note09186a008052d9a6.shtml
//www.cisco.com/en/US/products/sw/voicesw/ps556/products_tech_note09186a008052d9a6.shtml
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https://tools.cisco.com/bugsearch/bug/CSCsz99841
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Cisco Unified Communications Manager 管理を開き、システム > サービスパラメータを選
択して下さい。

1.

サービスパラメータの完全なリストを表示するために Advanced ボタンをクリックして下さ
い。

2.

クラスタのすべてのサーバの CDR Enabled フラグ パラメータをディセーブルにして下さい
。

3.

『Cisco』 を選択 して下さい統一されたサービサビリティ > Tools > Control Center -ネット
ワークサービス。

4.

クラスタのすべてのサーバのこれらのサービスを再開して下さい:Cisco CDR エージェント
Cisco Database Layer MonitorCisco CDR リポジトリ マネージャCisco CAR スケジューラー

5.

『Cisco CallManager Serviceability』 を選択 して下さい > Tools > Control Center -サービス
を特色にし、これらのサービスを再開して下さい:Cisco 石鹸- CDRonDemand サービス
Cisco CAR Web サービス

6.

CDR Enabled フラグ パラメータをクラスタのすべてのサーバのサービスパラメータの下で
再度有効に し、次に CDR レポートを実行して下さい。

7.

解決策 2

問題が残っている場合、Cisco Unified Communications Manager サーバのこれらの CLI コマンド
を実行して下さい。

//www.cisco.com/en/US/docs/voice_ip_comm/cucm/cucos/6_0_1/cucos/iptpappa.html#wp1052698
//www.cisco.com/en/US/docs/voice_ip_comm/cucm/cucos/6_0_1/cucos/iptpappa.html#wp1052698


車から SQL 選定された param_value を実行して下さい: tbl_system_preferences
param_name='MANUAL_PURGE_STATUS

1.

このクエリが 1 の param_value を戻す場合、0 に MANUAL_PURGE_STATUS をアップデ
ートするためにこのクエリを実行して下さい:SQL アップデート 車を実行して下さい:
tbl_system_preferences が param_value=0 を param_name='MANUAL_PURGE_STATUS 設
定 した0 への MANUAL_PURGE_STATUS をアップデートした後、Cisco CAR スケジュー
ラー サービスを再開して下さい。ローダーは Cisco CAR スケジューラー サービスの再始動
の後でうまく働きます。

2.

値が正しい場合、これらのクエリを実行して下さい:車から SQL 選定された param_value を
実行して下さい: tbl_system_preferences param_name='MIN_DATE車から SQL 選定された
param_value を実行して下さい: tbl_system_preferences param_name='CDR_MIN_DATE車
から SQL 選定された param_value を実行して下さい: tbl_system_preferences
param_name='MAX_DATE車から SQL 選定された param_value を実行して下さい:
tbl_system_preferences param_name='CDR_MAX_DATE

3.

このクエリを実行して下さい:車から SQL 選定された max（Error_Record_Id）を実行して
下さい: tbl_error_id_map

4.

クエリの結果を得、これを実行して下さい:SQL アップデート 車を実行して下さい:
tbl_system_preferences が前の query> からの param_value= <value を
param_name='MAX_ERROR_RECORD_ID 設定 した

5.

この場合 CAR レポートおよび CDR 検索を再度実行することを試みて下さい。

解決策 3

この問題はまたユーザがメール ID および Domain フィールドを追加しなかったら発生する場合が
あります。 Cisco Unified Communications Manager 管理 ページで、システム > サービスパラメ
ータ > メール パラメータを選択し、ユーザのメール ID （ユーザ名）および Domain フィールド
の domain-name が追加されるようにして下さい。

解決 4

システム > サービスパラメータを選択し、サービスパラメータのリストを表示する、CDR
Enabled フラグが本当に設定 されることを確かめるために Advanced ボタンをクリックして下さ
い。

解決策 5

 SQL  maxError_Record_Id実行して下さい: tbl_error_id_map クエリは返される結果に、1 つを
追加し。

1.

 SQL  入力して下さい: tbl_system_preferences  +1" クエリ param_value= " 。2.
システム > スケジューラー > CDR ロードを選択して下さい。 ローダーを『Disable』 を選
択 し、CAR ローダーをディセーブルにするために Update ボタンをクリックして下さい。
注: CDR データは CAR に CDR ロードを有効に するまでロードしません。 変更は深夜で実
施されます。 変更にすぐに実施されさせます CAR スケジューラー サービスを停止し、再開
して下さい。

3.

それを再び有効にするために、ディセーブル ローダー チェックボックスのチェックを外し
て下さい。 連続的なロードを 24/7 のチェックボックス チェックし、Update ボタンをクリ
ックして下さい。

4.

変更を有効にするためにすぐに、停止は CAR スケジューラー サービスを再開し。5.



ソリューション 6

次の手順を実行します。

[Start] > [Programs] > [Administrative Tools] > [Services] の順に選択します。1.
Cisco Unified CallManager CAR スケジューラー > ログインを右クリックし、ローカルシス
テム アカウントを選択して下さい。エラーが Computer.Error 1069  Cisco Unified

CallManager CAR  また、パスワードを同期する必要があります現われます。

2.

パスワードを同期するために、> adminutility > 選択しますすべてを > オプション > 設定 さ
れた新しいパスワード Start > Run の順に選択 して下さい。

3.

電子メールとして CDR レポートを送信 することが不可能

電子メールを通して CDR ファイルを送信 することを試みるときこのエラーメッセージが現れま
す:

Error Code 10011

Error Description System Error. Contact System Administrator.

注: レポートを表示できますがで eメールアドレスをへの入力した後 Send ボタンをクリックする
とエラーメッセージが現れます: フィールドの URL のみが置換されます。

解決策

この問題を解決するには、次の手順を実行します。

System > System パラメータ > メール パラメータを選択して下さい。メール パラメータ ウ
ィンドウは表示されます。

1.

メール ID フィールドでは、電子メールが送信 されるとき From フィールドで使用されるべ
き E メール ID を入力して下さい。注: 電子メール ID フィールドがドメイン 拡張なしで一杯
になることを確かめて下さい。 たとえば、電子メール ID が xyz.lmn@abc.com なら、ちょ
うど xyz.lmn でフィールドを記入して下さい アプリケーションのユーザーにメール ID フィ
ールドがないので、管理者アプリケーションのユーザーか同じようなユーザを使用しないこ
と確実でであって下さい。

2.

Password フィールドでは、サーバにアクセスするのに使用するパスワードを入力して下さ
い電子メール システムを実行する。注: CAR はユーザ ID およびパスワードを認証しません
。 メール サーバの認証をディセーブルにするか、または有効なユーザID およびパスワード
を入力して下さい。

3.

確認 Password フィールドでは、確認するためにステップ 3 から同じパスワードを入力して
下さい。

4.

メール Domain フィールドでは、電子メール システムを実行するサーバのためのドメイン
名を入力して下さい。

5.

ホスト名の代りにサーバの IP アドレスを（電子メール システムを実行する）使用するため
にメール サーバが設定 されることを確かめて下さい。

6.

変更を行なうために、Update ボタンをクリックして下さい。7.

エラーコード 10021

on Cisco CDR 分析および（CAR） Unified Communications Manager （CallManager） 5.X を報



告することから CDR 検索および CDR レポートにアクセスする試みが行われるときこのエラーメ
ッセージが現れます: エラーコード 10021 は。

データを収集する試みが行われるとき同様に CAR はデータを収集できないし、このエラーメッ
セージが現れます: 30023: 。

解決策 1

このエラーはディセーブル CDR ローダー チェックボックスがチェックインされた CAR の
とき発生する場合があります。 システム > スケジューラー > CDR ロードを選択し、問題を
解決するためにディセーブル ローダー チェックボックスをチェックを外して下さい。

1.

システム > サービスパラメータを選択し、サービスパラメータのリストを表示するために
Advanced ボタンをクリックして下さい。 CDR Enabled フラグが本当に設定 されることを
確かめて下さい。

2.

解決策 2

エラーコード 10012 のためのソリューションで述べられるステップを完了して下さい。

これらのソリューションが問題を解決しない場合、Cisco Technical Assistance Center
（TAC）に連絡して下さい。

次の手順を実行します。

2，000,000 のデフォルトに MAX_CDR_NUMBER をリセットして下さい。 CLI からこのク
エリを実行して下さい:admin: run sql update car:tbl_system_preferences set
param_value='2000000' where param_name='MAX_CDR_NUMBER'.

1.

システム > スケジューラー > CDR ロードを選択して下さい。 ローダーを『Disable』 を選
択 し、CAR ローダーをディセーブルにするために Update ボタンをクリックして下さい。
注: CDR データは CAR に CDR ロードを有効に するまでロードしません。 変更は深夜で実
施されます。 変更にすぐに実施されさせます CAR スケジューラー サービスを停止し、再開
して下さい。

2.

それを再び有効にして下さい、ディセーブル ローダー チェックボックスをチェックを外し
て下さい。 連続的なロードを 24/7 のチェックボックス チェックし、Update ボタンをクリ
ックして下さい。

3.

すぐに実施される変更のために CAR スケジューラー サービスを停止し、再開して下さい。4.

エラーコード 10012

Cisco Unified Communications Manager 5.x で、CDR レポートは生成されないし、エラーコード
を示します:

"10012.Database Error. Contact system administrator"

また、CAR イベントログはすべての CDR ローダー イベントが不成功であることを示します。
CAR スケジューラーのための debug trace はこのエラーメッセージを表示する:

ERROR [DailyCdrLoad] beans.EBSystemPreferences - save(): Error while saving

Sys Pref Data: MAX_DATE  null.

解決策

//www.cisco.com/en/US/support/tsd_cisco_worldwide_contacts.html
//www.cisco.com/en/US/support/tsd_cisco_worldwide_contacts.html


この問題を解決するには、次の手順を実行します。

最大日付を得るためにクエリを実行して下さい。run sql select param_value from

car:tbl_system_preferences where

param_name='CDR_MAX_DATE'

1.

tbl_system_preferences に表を挿入するために得られる上のクエリで最大日付を使用して下
さい。 mm/dd/yyyy 形式で日付ストリングを使用して下さい。"run sql insert into

car:tbl_system_preferences(param_name,param_value) values ('MAX_DATE',

'<mm/dd/yyyy>')"

2.

CAR スケジューラーおよび CAR Web サービスを停止して下さい。3.
0 に MANUAL_PURGE_STATUS をアップデートするためにこのクエリを実行して下さい
:run sql update car:tbl_system_preferences set param_value=0
where param_name='MANUAL_PURGE_STATUS'

4.

0 に MANUAL_PURGE_STATUS をアップデートした後、CAR スケジューラーおよび CAR
Web サービスを再開して下さい。

5.

この問題はまたこれらのエントリのうちのどれかが tbl_system_preferences 表から抜けている場
合発生する場合があります:

max_date●

min_date●

cdr_max_date●

cdr_min_date●

どのエントリが抜けているか確認するためにこれらのステップを完了して下さい:

車から SQL 選定された param_value を実行して下さい: tbl_system_preferences
param_name='MIN_DATE

1.

車から SQL 選定された param_value を実行して下さい: tbl_system_preferences
param_name='CDR_MIN_DATE

2.

車から SQL 選定された param_value を実行して下さい: tbl_system_preferences
param_name='MAX_DATE

3.

車から SQL 選定された param_value を実行して下さい: tbl_system_preferences
param_name='CDR_MAX_DATE

4.

この 4 つのエントリのうちのどれかが抜けている場合、このロジックを用いる表に戻ってそれを
挿入して下さい:

MIN_DATE が抜けている場合、CDR_MIN_DATE 値を検出し、MIN_DATE のような
tbl_system_preferences に値を挿入して下さい。

●

CDR_MIN_DATE が抜けている場合、MIN_DATE 値を検出し、CDR_MIN_DATE のような
tbl_system_preferences に値を挿入して下さい。

●

MIN_DATE 及び CDR_MIN_DATE が両方抜けている場合、tbl_system_preferences に両方の
カラムに '01/01/1970' を挿入して下さい。

●

MAX_DATE が抜けている場合、CDR_MAX_DATE 値を検出し、MAX_DATE のような
tbl_system_preferences に値を挿入して下さい。

●

CDR_MAX_DATE が抜けている場合、MAX_DATE 値を検出し、CDR_MAX_DATE のような
tbl_system_preferences に値を挿入して下さい。

●

MAX_DATE および CDR_MAX_DATE が両方抜けている場合、tbl_system_preferences に両
方のカラムに '01/01/1970' を挿入して下さい。

●

たとえば CDR_MIN_DATE が抜けていたら、これをして下さい:



MIN_DATE 値を取得して下さい:  SQL  param_value : tbl_system_preferences
param_name='MIN_DATE

1.

上でから値を、取得して下さい例えば: 01/01/2008 は、それから動作します:  SQL :
tbl_system_preferences CDR_MIN_DATE'01/01/2008';

2.

この問題はまたこれらの既知の問題が原因で発生する場合があります:

Cisco バグ ID CSCsk17300 （登録ユーザのみ）●

Cisco バグ ID CSCsg01364 （登録ユーザのみ）●

[TaskMonitor] controller.CtrNotifications に-
isManualPurgeRunning() 警告して下さい

レコードは CAR データベースで見つけられなかったし、CAR スケジューラー トレースはこのメ
ッセージを表示します:

"WARN  [TaskMonitor] controller.CtrNotifications - isManualPurgeRunning():

[Manual Purge] and [Continuous Loading 24/7] are both running, sleeps for 60

seconds ..."

tbl_system_preferences の出力は手動パージがオンになっていることを示したものです。

解決策

この問題を解決するには、次の手順を実行します。

CAR スケジューラー サービスを停止して下さい。1.
このクエリを実行して下さい:run sql update car:tbl_system_preferences set param_value='0'
where

param_name='MANUAL_PURGE_STATUS'

2.

CAR スケジューラー サービスを開始して下さい。3.
ディフォルトするためにローダー プロパティを設定 して下さい。4.
CAR スケジューラー サービスを再開して下さい。5.

CAR レポートの CMR 情報 NULL

CMR 情報は CAR レポートで NULL を示します。

解決策

問題を解決するために、これを確認して下さい:

コール 診断 パラメータが Cisco CallManagerサービス パラメータで有効に なることを確か
めて下さい:CDR Enable Parameter - Enabled
Call Diagnostics Parameters - Enabled

1.

ロード CDR だけがチェックされたかどうか確認して下さい。 そうである場合、それのチェ
ックを外して下さい。

2.

警告： このクラスタのいくつかのサーバでは CDR Enabled フラ
グは偽であり、従って CDR エントリはこのクラスタでなされる

https://tools.cisco.com/bugsearch/bug/CSCsk17300
//tools.cisco.com/RPF/register/register.do
https://tools.cisco.com/bugsearch/bug/CSCsg01364
//tools.cisco.com/RPF/register/register.do


すべてのコールのために生成されないかもしれません

CDR データを集めることができこのエラーメッセージが現れます:

Warning : In some servers in this cluster the CDR Enabled Flag is false and so CDR entries

may not be generated for all the calls made in this cluster.

解決策

CDR Enabled フラグが Cisco Unified Communications Manager サーバの本当に設定 されること
を問題を解決するために、確かめて下さい。

CAR スケジューラー サービスはハングします

ザ・カー スケジューラー サービスは多数の加工されていない CDR/CMR ファイルをハングさせ
、残します。 パーティションが自動削除されるとき CAR スケジューラーにハイメモリ 使用方法
があります。

この問題は Cisco バグ ID CSCta71863 （登録ユーザのみ）で文書化されています。

解決策

この問題を解決するために、60 日のデフォルトか大きい値に CAR 自動パージ ページで設定可能
、より 34 である MAX_CAR_DATABASE_AGE 設定を高めて下さい。

Java.sql.SQLException エラー

CAR の CDR ロードはこの SQL エラーと断続的に失敗します: java.sql.SQLException: 
informix.xxx -710 

この問題は Cisco バグ ID CSCsr05092 （登録ユーザのみ）で文書化されています。

解決策

この問題の回避策を次に示します。

そのような SQL エラーがつかまえられる時はいつでも CAR スケジューラー サービスを再
開して下さい。

1.

より頻繁なローダー スケジュールを設定して下さい。 たとえば、15 最小値毎に 13 最小値
をロードして下さい。

2.

不正確な時間 間隔のエクスポート ファイルを送信 して いる
CAR スケジューラー

ザ・カー スケジューラーはスケジューラーで定義されたように 1 時間あたりの 1 分あたりエクス
ポート ファイルをの代りに一度二度送信 して います。

解決策

https://tools.cisco.com/bugsearch/bug/CSCta71863
//tools.cisco.com/RPF/register/register.do
https://tools.cisco.com/bugsearch/bug/CSCsr05092
//tools.cisco.com/RPF/register/register.do


問題を解決するために、1 からシステムパラメータの 60 に CDR ファイル タイムインターバルを
変更して下さい。

エラー： CDR フラグは有効に なりません

CDR オプションに到達することを試みるとき CDR  Enabled 受け取られます。

解決策

この問題を解決するために CallManager Server でこれらのステップを実行して下さい:

エンタープライズ パラメータに行き、これらを設定して下さい:CDR ファイル タイムイン
ターバル = 1クラスタ ID = StandAloneCluster

1.

サービスパラメータに行き、サービスとして『Cisco CallManager』 を選択 し、これらを設
定して下さい:CDR Enabled フラグ = 本当ゼロ期間 フラグの CDR ログ呼び出し = 本当CDR
Enabled フラグに関係なく有効に なる = 有効に なる コール 診断

2.

CAR は読解可能な CSV 形式でない報告します

Cisco Unified Communications Manager 5.x およびそれ以降に関しては、CAR CSV View レポー
ト出力はきちんと読解可能フォーマットされていないし。

解決策

この動作は根本的なプラットフォームが Cisco Unified Communications Manager 5.x およびそれ
以降のための Linux であるのであります。 レポートをこのセクションで提供される回避策を使用
してレベルにフォーマットされていて作成できます。 それは Linux プラットフォームがはたらか
せる方法が理由でそうなったものです。

この問題は Cisco バグ ID CSCtb75858 （登録ユーザのみ）で文書化されています。

可能性のある回避策としてこのプロシージャを行って下さい:

Microsoft Excel を開いて下さい。1.
File > Open の順に進んで下さい。2.
テキストファイル（*.pm を選択して下さい; 型のファイルのための *.txt、*.csv）。3.
report.txt ファイルを見つけ、開いて下さい。4.
テキスト Import ウィザードから- 3 ウィンドウのステップ 1 は元データ データ タイプの下
で、固定幅をようにファイルタイプ選択します。 次に、[Next] をクリックします。注: ファ
イルタイプとして区切られて選択する場合、これはデータの切り捨てという結果に終る場合
があります。

5.

テキスト Import ウィザード- 3 ウィンドウのステップ 2 は、horizonal スクロールバーを全
体の列に行き、これらのステップを完了するのに使用します:ダブル クリックの不必要なカ
ラム中断を削除して下さい。望ましい位置で単一クリックの抜けたカラム中断を追加して下
さい。[Next] をクリックします。

6.

テキスト Import ウィザードから- 3 ウィンドウのステップ 3 は、『Finish』 をクリック しま
す。

7.

データは Excel セルで表示する。 よりよい読みやすさのためのこれらの項目を行うことが8.

https://tools.cisco.com/bugsearch/bug/CSCtb75858
//tools.cisco.com/RPF/register/register.do


   

できます:配置を調節して下さい表の左上のコーナーをクリックして全表を選択して下さい
ツールバーの左配置ボタンをクリックして下さいセル幅に適当なデータ 長を自動的にする
ために、何れかの 2 つのカラムの間でダブル クリックして下さい。

関連情報

CDR の概要（Call Detail Records）●

Cisco Unified CallManager 4.1 が Cisco Unified CallManager 4.2 にアップグレードされた後
、CMR ファイルはサーバの高CPU 使用方法という結果に終る CDR データベースに挿入され
ません、

●

音声に関する技術サポート●

音声とユニファイド コミュニケーションに関する製品サポート●

テクニカルサポートとドキュメント - Cisco Systems●

https://supportforums.cisco.com/docs/DOC-13842?referring_site=bodynav
https://supportforums.cisco.com/docs/DOC-2687?referring_site=bodynav
https://supportforums.cisco.com/docs/DOC-2687?referring_site=bodynav
https://supportforums.cisco.com/docs/DOC-2687?referring_site=bodynav
//www.cisco.com/cisco/web/psa/default.html?mode=tech&amp;level0=268436015&amp;referring_site=bodynav
//www.cisco.com/cisco/web/psa/default.html?mode=prod&amp;level0=278875240&amp;referring_site=bodynav
//www.cisco.com/cisco/web/support/index.html?referring_site=bodynav
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